
track

One row of the Track View Window which can contain a sequence of measures, and has attributes such as a Track 
Name, Instrument, Channel, etc.



registered copy

A version of Music Sculptor identical to the shareware evaluation copy except that the introductory information 
screen is not present and the About Dialog Box identifies it as a registered copy instead of a shareware evaluation 
copy.    Only the shareware evaluation copy is to be distributed.



Introduction

Welcome!

Music Sculptor is a MIDI sequencer that allows you to:

-    Play MIDI songs

-    Record MIDI songs

                from an external MIDI input device such as a MIDI keyboard 

                or

                from a Keyboard Window that can be played with the mouse or computer keyboard

-    Edit music by: 

-    cutting, copying, and pasting measures

-    adjusting volume and pitch

-    adjusting tempo and time signature

-    changing instruments

-    naming tracks

-    changing channels

-    Open and Save standard midi files

Music Sculptor works with any synthesizer and sound card compatible with Windows 3.1 or later.

(Note:    Versions 1.0 and 1.5 of the Soundblaster Card don't support simultaneous use of the MIDI IN and MIDI 
OUT ports)

Some sample public domain midi files are included.

Enjoy!



What Is A MIDI Sequencer?

MIDI stands for "Music Instrument Digital Interface".    It's a standard for transmitting musical information 
between electronic instruments and computers.    The musical information is similar to a roll on a player piano.    It 
specifies at which time each note is to be played and for how long.    Other information includes the pitch of each 
note and with which instruments to play the notes.

A MIDI Sequencer is like a word processor of music.    It allows you to record, edit, and play this MIDI 
information.    For example, to compose a song using a MIDI sequencer you might first record a drum track by 
playing a music keyboard which transmits the drum notes to the MIDI sequencer.    A bass track might then be 
recorded to this beat, while the previously recorded drum track is played back.    To play the song, the MIDI 
Sequencer sends the MIDI information to an electronic instrument (for example, a sound card).    You could edit the 
song using the MIDI Sequencer by changing the bass instrument to a flute and making it play back twice as fast for 
example.    When finished, the song can be saved to disk.



Order Form for Music Sculptor 1.7 and/or the ASP CD-ROM

If you have a printer you may print this form by selecting Print Topic from the File menu.    Otherwise 
please write this information on a sheet of paper. 
Please mail to:

Aleph Omega Software

Box 61085

Kensington Postal Outlet

Calgary, Alberta

T2N 4S6

Canada

Your Name: ________________________________________________________________

Address: ________________________________________________________________

City: ________________________________________________________________

State/Prov: ________________________________________________________________

Zip/Postal Code: ________________________________________________________________

Phone: ________________________________________________________________

Electronic Mail Address (if applicable):_________________________________________________

                    Disk Format:        3-1/2"___        5-1/4"___

Where did you obtain Music Sculptor? _________________________________________________
Desired Features, Bug Reports, Questions, and Comments ______________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

(The following prices include shipping and handling.)

$29.95 x _______ (number of copies of Music Sculptor) = __________

$29.95 x _______ (number of copies of ASP CD-ROM)      = __________

                                                                                                                                          TOTAL = __________

Thank you very much for your support!



Equivalent in Canadian or British Funds

The equivalent of $29.95 US is $39.98 Canadian or £19.92 British.    (GST included).



Hmmm...    Tell Me More...

Do you have a lot of questions in your mind?    Are you wondering:

"How does shareware work?" 

"What will I receive when I register?"

"How can I register?" 

"When a cow laughs, does milk come out of her nose?"

I will attempt to answer most of these questions below. 

Music Sculptor is being distributed as shareware.

Shareware is a way of marketing software that allows you to "try before you buy".    Two disadvantages of 
commercial software are that :

1) You can't return it after purchasing if it doesn't suit your needs.

2) It is expensive because of high advertising and other marketing costs which are passed on to the user.

Shareware is the ultimate money back guarantee because it allows you evaluate the software on your own 
particular computer system and decide if it works for you.

Shareware is significantly less expensive than commercial software because the marketing costs are minimal.

Music Sculptor may be evaluated for 30 days.    If you continue to use it thereafter, you are required to register it as 
a licensed user by sending $24.95 US + $5.00 Shipping and Handling (or the equivalent in Canadian or British 
funds) to Aleph Omega Software (please see order form below).

Benefits upon Registration

+ You will be entitled to free technical support by mail, phone, or electronic mail 

    ( Phone: (403) 257-2115 )

    ( Internet: 72613.3574@compuserve.com )

    ( CompuServe: 72613, 3574 )

+ Lifetime Guarantee: if you are unsatisfied for any reason after registering you may simply return your 
registration package for a full refund

+ You will be notified of future versions as soon as they become available

+ You will be entitled to inexpensive upgrades to future versions

You will be sent a package containing the following:

+ a registered copy of the latest version of Music Sculptor 

+ a printed manual for Music Sculptor

+ a mini-encyclopedia explaining in understandable language about 100 terms related to MIDI under Windows.    
This is a file in Microsoft Write format.

+ a collection of 200 MIDI files

+ information on obtaining a significant discount on the subscription price offered by Shareware Magazine to 
people who register shareware

+ information on obtaining a credit offered by CompuServe to new users brought to them by way of a shareware 



registration

+ the fully functional Windows program Digital Audio Playback Facility.    This very attractive application looks 
like a stereo system and allows you to simultaneously play MIDI files, Wave files, and CD Audio.

+ a fully functional evaluation version of WHAM, an attractive graphical Windows 3.1 application for 
manipulating digitized sound.    It can read and write Wave files, raw eight-bit digitized sound files, IFF, VOC, 
AIFF, and AU files and can perform various operations on this sound. WHAM can handle sounds of any size, 
restricted only by memory.

+ a fully functional evaluation version of Wave After Wave, a Windows application that plays MIDI and Wave 
files one after the other automatically while avoiding the dreaded File/Open and Play routine.    It also plays CD 
Audio, allows file deletion, and dragging and dropping of MIDI and Wave files from File Manager.

+ a fully functional evaluation version of Improvise, a program that composes algorithmic MIDI music in real 
time, on up to sixteen channels at once.    You can control parameters governing pitch, rhythm, tempo, texture, etc. 
as the music plays, immediately hearing the effect of all changes -- or simply let the program produce endlessly 
new music, without requiring any real time interaction on your part.    You can save groups of settings and 
parameters, optionally including a map of MIDI programs and/or a 'mix' of MIDI volume information, allowing 
you to preserve your algorithmic compositions either for later reproduction, or as the basis for future musical 
explorations.    You can also save MIDI program maps and 'mixes' independently of settings and parameters.    
Algorithmic MIDI output can also be saved directly to a Standard MIDI file, permitting later playback and editing 
of 'live' real-time algorithmic performances.    Improvise can be used in many ways -- for example, to produce 
background music on the desktop, to compose, to 'play' a virtual algorithmic instrument, and to produce MIDI 
output for the use of other programs.    ( Such as...    hmmm...      Music Sculptor!    just to cite a random, unbiased 
example    :-)    )

Music Sculptor has not been crippled in any way or poisoned with a plethora of annoying nag messages that 
threaten cruel and unusual punishment for not registering.    I trust you to support Music Sculptor if it meets your 
needs and you enjoy using it.    Thank you!

Please    click on the words order form to order by US, Canadian, or British cash, check, or money order.

Alternatives:

Credit Card Orders

CompuServe Registration

Special Offer: Association Of Shareware Professionals CD-ROM

Please note that you need not feel guilty about giving out copies of this Shareware Evaluation Copy of Music 
Sculptor.    In fact you are encouraged to do so to help it become more widely distributed. 

( As for the cow question: some questions are better left unanswered.    :-)    )



Measure Region

This is the area on the right side of the Track View Window where the measures for each track are displayed.

Groups of measures may be selected here.    Once selected, they may be manipulated using the Edit Menu 
Commands. 

Only measures that contain MIDI events such as notes are displayed.

The top row displays the measure numbers starting at 1.    A rectangular box on this row indicates the current 
measure.    Click in this row to change the current position.



Trk Column

The number of each track is displayed here.    This is not to be confused with the channel number for the track.



Ply Column

Ply is an abbreviation for Play.    Click in this column to enable a track for playing.    This means that the track is 
sent to the MIDI output device when the play button is pressed. 

The play enabled track is indicated by a P.

Click again to remove the P.    This will mute the track.

A track can be play enabled and disabled while it is playing.



Rec Column

Rec is an abbreviation for Record.    Click in this column to enable a track for recording.    This means that notes 
will be recorded into the record enabled track when the record button is pressed.

The record enabled track is indicated by an R.

Also, the instrument of the record enabled track is used as the instrument for the Keyboard Window.



channel

All notes ( and many other MIDI messages ) have an associated channel numbered from 1 to 16.    A synthesizer or 
sound card can associate exactly one instrument to each channel. 

For example, a flute sound may be associated with channel 2 and a guitar sound with channel 3.    Then all notes 
sent to the sound card on channel 2 will sound like a flute and all notes sent to the sound card on channel 3 will 
sound like a guitar. 

When a channel is assigned to a track in the Ch Column, all notes ( and other MIDI messages ) in that track are 
sent to the sound card on that channel during playback.

It is possible for a single track to contain notes associated with different channels.

If * is selected in the Ch Column, each note in the track is sent on the channel associated with that note.

The percussion channel is special in that the regular melodic instruments don't apply.    Instead each note has a 
different percussive sound associated with it.    When using General MIDI, the percussion channel is either 10 or 16 
depending on whether    the synthesizer is high end (extended level) or low-end (base level), respectively.



Ch Column

Ch is an abbreviation for Channel.    Click in this column to change the channel for the track.



general midi

A synthesizer standard that assigns specific instruments to each instrument number.    For example, instrument 
number 1 is Acoustic Grand Piano.



Instrument Column

The instrument column contains the instrument for each track.

Click in the heading of this column to change its width.

 If you click in this column the Select Instrument dialog box will appear.

Select General MIDI if your sound card or synthesizer supports General MIDI instruments and you would like to 
use them.

Otherwise, select Instrument Number ( 1 - 128 ).    Refer to your synthesizer or sound card manual for a table 
describing which instrument corresponds to each instrument number ( also known as Program Change number or 
Patch number ).

General MIDI instruments can be selected from the menu on the left.

Instrument Numbers can be selected from the list box on the right.

Instruments can be changed while a song is playing.    It's very useful ( and fun! ) to try out different instruments 
for a track as it plays.

An instrument selection will only take effect if a channel number from 1 to 16 has been selected for the track in the 
Ch Column.

The percussion channel is special in that the regular melodic instruments don't apply.    Instead each note has a 
different percussive sound associated with it.    When using General MIDI, the percussion channel is either 10 or 16 
depending on whether    the synthesizer is high-end (extended level) or low-end (base level), respectively.



Track Name Column

This column contains the name of each track.    For example, Melody, or Bass Line, or Drums.

Click in this column to change the track name.

Click in the heading of this column to change its width.



Track View Window

The Track View Window allows you to view and change the tracks of the song.    It contains the following areas:

Track Name Column

Instrument Column

Ch Column

Rec Column

Ply Column

Trk Column

Measure Region



Keyboard Window

This window can be used like a music keyboard to play notes using the mouse or computer keyboard.

The instrument used to play these notes is the instrument of the track currently enabled for recording, as indicated 
by the R in the Rec column of the Track View Window.    The channel of this track is used as well.    The instrument 
name is displayed in the title bar of the Keyboard Window.

When the record button is pressed, any notes played will be recorded into the record enabled track.

Each key is labeled with a pitch number from 0 to 127 and the name of the note, such as C#.

The Keyboard Window may be scrolled left and right using its scroll bar to access lower and higher pitched keys, 
respectively.

To Play Using The Mouse

The left mouse button is used to press and release keys.

The right mouse button is used to hold keys down until pressed again.    This is useful for playing chords.

To Play Using The Computer Keyboard

The top row of keys containing the numbers is used for the black keys in the keyboard window.

The row below this containing the keys TAB    Q    W    E    R    T    Y    etc... is used for the white keys in the 
keyboard window.

For example, to play the leftmost white key, press the TAB key.    To play the white key to the right of that one, 
press the Q key.

Several keys may be held down simultaneously for chords, etc...



Track Button

The track button displays and maximizes the Track View Window.



Keyboard Button

The keyboard button displays and maximizes the Keyboard Window.



Tempo

This adjusts the speed of the song.    Press the up arrow to increase the tempo and the down arrow to decrease the 
tempo.    Tempo is in beats per minute. 

The above example indicates a tempo of 120 beats per minute.



Play Button

Press the play button to begin playing all tracks that are currently enabled for playing, as indicated by a P in the Ply 
Column of the Track View.

Playing will begin at the current position.

Press the stop button to stop playing.



clock

A division of a beat.    There are 240 clocks per beat ranging from 000 to 239.



beat

A division of a measure determined by the time signature. 



Current Position

Displays the current location within the song, in terms of measure and beat

The above example indicates the first beat of the first measure.    This is the beginning of the song.

To change the current position, click on the measure number that you would like to change it to in the top row of 
the measure region.



Rewind Button

Press the rewind button to reset the current position to    001 : 01 : 000 and scroll back to the beginning of the song. 
This button will also stop playing or recording.



Stop Button

Press the stop button the stop playing or recording.



Record Button

Press the record button to begin recording in the track that is currently enabled for recording, as indicated by the R 
in the Rec column of the Track View Window.

You can record from:

 - a hardware MIDI input device attached to your computer, such as a MIDI keyboard

or

- the Keyboard Window using the mouse

Any tracks that are currently enabled for playing, as indicated by the P in the Ply column of the Track View 
Window will play during recording.

Recording will begin at the current position.

Press the stop button to stop recording.



The Toolbar

Select the toolbar item you would like help on.



output device

An output device is either the Microsoft MIDI Mapper or a real hardware MIDI output device installed in your 
system.    You must select the correct output device before playing a song.

If your output device is not displayed in the list, it must be installed using the Drivers application of the Control 
Panel.    Please refer to the documentation for your sound card and your Windows manual for details.

The Microsoft MIDI Mapper is a program that changes MIDI events to a form specific to a certain real hardware 
MIDI output device.    It can be adjusted using the MIDI Mapper application of the Control Panel.    Please refer to 
the documentation for your sound card and your Windows manual for details.

Some output devices can only be used by one program at a time.



measure

A section of a track containing a number of beats equal to the top number of the time signature.



time signature

Determines how the song is divided into measures.    The top number represents the number of beats in one measure. 
The bottom number indicates what note length is equal to one beat.    For example, a 3/4 time signature means there 
are 3 beats in one measure and each quarter note is a beat.    A 6/8 time signature means there are 6 beats in one 
measure and each eighth note is a beat.



Settings Menu Commands

Wide Track Name

When this is selected (indicated by a check mark), the Track Name Column is widened so that longer track names 
can be displayed.    Select this item again to return the Track Name Column to its original width.

Clicking the heading of the Track Name Column has the same effect.

Wide Instrument

When this is selected (indicated by a check mark), the Instrument Column is widened so that longer instrument 
names can be displayed.    Select this item again to return the Instrument Column to its original width.

Clicking the heading of the Instrument Column has the same effect.

Metronome Beeps

When this is selected (indicated by a check mark), a beep will sound on each beat.    This provides a rhythm to play 
along to when recording.    Usually this is used to record a drum track at the correct tempo.    Once this drum track 
is recorded, select this item again to turn off the (annoying) beeps.

Time Signature

Allows the time signature for the current song to be set. 

Output Devices

Allows the midi output device to be selected.



pitch

Each note has an associated pitch ranging from 0 to 127.    This is the number displayed for each key in the 
Keyboard Window.    For example, Middle C has pitch 60.    The C# after Middle C has pitch 61.    The difference 
between pitch 60 and pitch 61 is one semitone. 



velocity

Each note has an associated velocity ranging from 0 to 127 corresponding to how fast its key was struck when the 
note was recorded.    Generally, the higher the velocity, the louder the note will sound.



insertion point

The highlighted measure in the Track View Window where the left mouse button was clicked.



selected measures

The measures in the Track View Window which have been highlighted by clicking on a measure with the left 
mouse button and dragging over the remaining measures with the left mouse button held down.



Edit Menu Commands

Undo

Reverses the effect of the last Edit command ( Cut - Leave Hole, Cut - Delete Hole, Copy, Paste, Paste Repeatedly, 
Adjust Volume, and Adjust Pitch ).

For example, if you Paste some measures at a certain position and then decide that this was a mistake, simply 
select Undo.

Cut - Leave Hole

Removes the selected measures from the song, leaving empty measures in their place.

The measures can then be pasted using the Paste or Paste Repeatedly commands.

Cut - Delete Hole

Removes the selected measures from the song and moves measures to the right over to fill the gap.

The measures can then be pasted using the Paste or Paste Repeatedly commands.

Copy 

Copies the selected measures from the song, leaving the original intact.

The measures can then be pasted using the Paste or Paste Repeatedly commands.

Paste

Places previously Cut or Copied measures into the song at the insertion point.

This command becomes available when measures have been Copied or Cut.

Paste Repeatedly

Repeatedly places previously Cut or Copied measures into the song at the insertion point.

You can enter the number of times to paste.    The measures are then pasted one after the other.

This command becomes available when measures have been Copied or Cut.

Adjust Volume

Increases or decreases the volume of the selected measures. 

You can enter a number to add to or subtract from the velocity of the notes in the selected measures.

Adjust Pitch

Increases or decreases the pitch of the selected measures.

You can enter a number to add to or subtract from the pitch of the notes in the selected measures.



File Menu Commands

New

Open a new song.

When you choose New, you can save changes to the song you have been working on.

Open

Opens a song.    You can open any standard midi file.

A song may also be opened when Music Sculptor is launched by specifying its name as a command line parameter. 
For example, to open song.mid when Music Sculptor is launched, select the Music Sculptor icon in Program 
Manager.    Then select Properties from the File menu in Program Manager and add song.mid to the end of the 
Command Line field following music.exe and separated by a space.

Save

Save changes to the song you have been working on.

When you choose Save, the song remains open so you can continue working on it.

Save As

Save as a new or existing song. 

You can name a new song or save an existing song under a new name.    When you choose Save As, the song 
remains open so you can continue working on it.

Revert To Saved

Discard all changes made to the song since it was last saved.    This allows you to experiment easily by saving the 
song, then making some changes, and then reverting to the saved song if the changes turned out to be undesirable.

Exit

Closes the song you have been working on and quits Music Sculptor.

You can save the song before quitting.



Keyboard Shortcuts

Record Ctrl+R

Rewind Ctrl+W

Stop Ctrl+S 

Play Ctrl+P

In addition, the SPACE BAR toggles between Stop and Play.

Keyboard Window Ctrl+K

Track Window Ctrl+T

Open Ctrl+F12

Save Shift+F12

Save As F12

Exit Alt+F4

Undo Ctrl+Z

Cut - Leave Hole Shift+Del

Cut - Delete Hole Del

Copy Ctrl+Ins

Paste Shift+Ins

Help F1



Help Menu Commands

Contents

Displays the on-line help contents topic.

How to Use Help

Explains how to use the on-line help system.

About

Display information about Music Sculptor, including version number.



Contents for Music Sculptor

To learn how to use Help,    press F1.

Introduction

What Is A MIDI Sequencer?

Windows

Keyboard Window

Track View Window

Toolbar and Commands

The Toolbar 

File Menu Commands

Edit Menu Commands

Settings Menu Commands

Window Menu Commands

Help Menu Commands

Keyboard Shortcuts



Window Menu Commands

Tile

Arranges the windows so that each window is visible and none overlap. 

Cascade

Arranges windows so that they overlap.

Names of Open Windows

To make a window active, choose its name from this list.    All open directory windows are listed, including those 
that have been reduced to icons. 



CREDIT CARD ORDERS ONLY

You can order with MC, Visa, Amex, or Discover from Public (software) Library by calling 800-2424-PsL or 713-
524-6394 or by FAX to 713-524-6398 or by CIS Email to 71355,470.    You can also mail credit card orders to PsL 
at P.O. Box 35705, Houston, TX 77235-5705.    The product number for Music Sculptor is 11251.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.

Any questions about the status of the shipment of the order, refunds, registration options, product details, technical 
support, volume discounts, dealer pricing, site licenses, etc, must be directed to Aleph Omega Software at 403-257-
2115.

To insure that you get the latest version, PsL will notify us the day of your order and we will ship the registration 
package directly to you.



COMPUSERVE REGISTRATION

You may register via CompuServe by typing GO SWREG at the CompuServe prompt.    The Registration ID for 
Music Sculptor is 2294.    The registration fee will be charged to your CompuServe account.    To insure that you 
get the latest version, CompuServe will notify us the day of your order and we will ship the registration package 
directly to you.



ASSOCIATION OF SHAREWARE PROFESSIONALS CD-ROM

The Association Of Shareware Professionals CD-ROM contains over 1100 shareware programs directly from the 
author members of the ASP.    This is the standard CD-ROM of the "Best of the Best" software in the shareware 
industry.    It is unique in being the most up to date and highest quality shareware CD-ROM. 

The latest ASP CD-ROM may be ordered for $24.95 + $5.00 US Shipping and Handling from Aleph Omega 
Software.    Please use the Order Form to order.    The Credit Card or CompuServe Registration methods can only 
be used to register Music Sculptor, not to order the ASP CD-ROM.    You may, of course, order the ASP CD-ROM 
without also registering Music Sculptor.




